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1. PRIOR INFORMATION

Specifications
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Print Technology:
Physical Dimensions:
Weight:

Extrusion Fused Filament Fabrication (FFF)
$370 mm x 560 mm
7 kg (without spool)

Printing Volume:

Diameter: 170mm
Height: 180mm

Number of extruders:

Layer height:

0,1-0,35mm (with standard O,4mm nozzle)
0,2-0,5mm (with 0,6mm nozzle)

Positioning resolution:

XY and Z axis: 0,05mm

Working temperature: 15-35°C
Max. extruder temperature: 260°C
Filament diameter: 3mm
Compatible materials: PLA

Electronics: Arduino Mega 2560 + RAMPS 1.4
Connectivity: SD Card (autonomous operation)

USB Cable (controlled through Repetier Host)
Firmware: Especifico BCN3DR (basado en Marlin)

Compatible files:

Code converter software:
AC Input:

Power requirements:

STL

Slic3r, Cura

AC 100-240V, ~0.2-0.4 amps, 50-60 Hz
60W
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FFF Technology

BCN3DR is a 3D printer based on fused filament fabrication additive manufacturing technology, consisting in the
deposition of melted material layer by layer based on a previously divided digital model.

The head makes the necessary movements to deposit a layer of material, then a slight vertical movement to continue

with the next layer. The process is repeated until the full object is completed.

The filament is lead to
the extruder through
the bowden

The heatblock fuses the filament (:l:
to a workable temperature

7 The hot filament is extracted through

the extruder with a smaller diamater

The printing surface
remains still

The material is distributed through
the model when necessary

Through rotation, the extruder uses a
hobbed bolt to insert the right amount
of filament
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Compliance

Fundaci6 Privada Centre Cim hereby states that BCN3DR complies with the essential requirements and other rele-
vant provisions of the following Directives:

Low Tension Directive 2006/95/CE
Directive on machinery 2006/42/CE
Directive RoHS2011/65/UE
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Safety

To avoid possible residual risks for the user, please read carefully the following safety measures.
REPRAPBCN IS EXEMPTED OF ANY LIABILITY IF THE USER DOES NOT FOLLOW THE FOLLOWING HANDLING
INSTRUCTIONS:

= Veryimportant. Like with any other appliance, do not touch the terminals of the cables connected to
the main. The voltage is 230V and there is a risk of electrocution. Other cables from the machine working
at 12V and present no risk.

» This machine produces and emits radio frequencies during use. It is important to install and use

the equipment according to the instructions in this manual to avoid harmful interference to domestic
appliances such as television or radio. If the machine causes interference, increase the separation bet-
ween it and other appliances.

= Print materials are not innocous and may emit toxic fumes. Always print in open or vented spaces.

» Do not breathe closer to 25cm from the extruder head or heads when printing.

= Do not place any object or body part between the moving parts of the machine when
functioning.

= Do not touch its hot parts (hotbed and hotend) when the machine is turned on, or within 15
minutes of operation.

= Do not connect or disconnect any device and/or electrical connector when the machine is on.
» Oversee proper function of the machine during operation.

» In case of an emergency, stop the machine using the STOP button and unplug.




__________User Mapu3l

RepRapBCN

Safety warnings

The following signs have been arranged on the printer to warn users about areas of potential risk arising from its use or
possible actions that are not recommended.

Hot Surface, allow it to cool down before handling.

&

Moving parts, danger of crushing, disconnect before handling
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2. SETTING UP YOUR BCN3DR

Unboxing

The BCN3DR kit is delivered inside a properly secured cardboard box.

= Printed parts

= Sheet metal panels

» Rods and bars

= NEMA 17 motors

» Arduino Mega, Ramps 1.4, LCD and Pololus drivers
= Wiring

= Fans

= Screws , bearings and belts
» Bowden tube and BCNozzle
» Glass printing surface

» SD card

= Power supply cable

= Power supplier

= 1Kg PLA spool

= Adhesive spray (3DLAC)

= Tools
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Tools and accessories

The BCN3DR comes with a kit with every tool necessary to build the printer from scratch included. It also includes a
fixing spray specially design for 3d printing.

Allen wrenches

ot Pliers

Flat screwdriver Phillips screwdriver
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BCN3DR diagram

Perspective Left view

—

1. LCD Screen 6 Endstop

2. SD Card Slot 7. Stepper motors

3. Hot end 8. Power supply

4, Extruder rod guides S. ON/OFF button

5. Lineal guides 10. Spool holder
11. Extruder
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Hot end
1. Heatsink
2. Heat break
3. Heatblock
4, Nozzle
5. Hotend fan
Extruder
6. Idler
7. Tightening screws
8. Bowden tube
9. Pneufit
Electronics
10. Drivers (Pololus)
11. Arduino + RAMPS
12. USB connector

RepRapBCN
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3. STARTUP PROCESS
Hotbed height calibration
For a proper use, the nozzle movement must be parallel to the Hotbed Surface.

To achieve that, there are three screws available to calibrate its orientation.

There is a risk of the nozzle hitting the hotbed glass so the first layer not sticking on its surface when the base is decalibra-
ted. The following steps must be followed:

1. Click on Autohome (Prepare > Autohome) so the printer axes move to their initial position.

2. Tighten the three M5 screws located on the printing surface to compress the springs holding the base in order to
lower it.

3. Untighten the same screws five turns so the nozzle does not collide with the glass in preparation for the next step.
4. Click on Prepare > Move Axis > 1 mm > Move Z to move the extruder platform to Z:+000.00 mm.

5. Move the nozzle closer to the X tightening screw following the glass surface. To do that, click on Prepare > Move
Axis > 1 mm > Move X and set it to X: -085.0mm.

6. Untighten once more the closest screw until the nozzle tip is 0.2mm from the glass. Use a folded paper to check
the distance, at 0.2mm it should slightly graze both the nozzle and the glass.

7. Move the nozzle close to the front tightening screw. To do that, click on Prepare > Move Axis > Tmm > Move X and set it
to X: +060.0mm and in menu Y set it to Y: -060.0mm.

8. Repeat the levelling process using a folded paper.

9. Move the nozzle close the rear tightening screw. Follow the same -
procedure and use the values X: +045.0mm and Y: +060.0mm.
10. Repeat the levelling process using a folded paper. |
11. To finish up, move the nozzle back to the first screw leveled using
the values X: -085.0mm and Y: +000.0mm. / \

12. Once again, level it using a folded paper. CU 13
P @) 4 |h /
) — f d_| | /
= --i;% ot
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Loading filament

One of the more common operations in our BCN3DR will be, for several reasons, loading and unloading filament: a
change of color, a change of material, using a fresh spool, cleaning, maintenance...

= Unloading:

1. Heat the extruder selecting Preheat PLA in the menu.

2. Click on Prepare > Move Axis > 1 mm > Extruder and rotate the wheel slightly clockwise to extrude a few milli-
metres of material. This procedure will help prevent jams.

3. Click on Prepare > Move Axis > 1 mm > Extruder and rotate the wheel anticlockwise a 100mm moving the gear a
few steps back until the filament is free.

4. Untighten the two idler screws on the extruder.

5. Manually extract all the filament from the Bowden tube.

»  Loading:

Once the thread is out, disconnect the Bowden tube from the hotend connector. The easiest way to do that is by
following these steps:

1. Tighten the Bowden tube to the end from below.

2. Manually open the latch taking care not to crush the tube.

3. Pull the tube out of the connector

4. Untighten the two idler screws on the extruder.

5. Select Preheat PLA in the menu and insert the filament along the whole tube until 20mm stick out of it.

6. With the help of some pliers, insert the plastic thread into the hotend until filament is extruded through the
nozzle. If necessary, push the filament from the extruder deeper inside the tube.

7. 0nce the nozzle is full of filament, grab the end sticking out of the extruder and pull it out while, at the same
time, inserting the tube into the connector.

8. Once the Bowden tube is firmly held by the connector, slightly tighten the idler screws by hand.

9. Once this is done, the filament is loaded and the machine ready to print.

r
13
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4.LCD CONTROL

The BCN3DR can be operated from its LCD menu, a single button combining two movements:

= Turn to move through the menu.
= Click to select desired option.

Adjacently to the control button there is an emergency red button to stop the machine in case of malfunction. It
stops the printer but keeps the screen and fans on. Once pressed, the printer resets itself to resume use.

Home Screen

The main screen reports on the status of the printer at the time of the printing currently in progress.

1. Printing speed (Fr) 4, Status bar and time elapsed
2. Printing height indicator (2) 5. Notifications
3. Percentage of printing program read (SD) 6. Target/Current temperature
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Printing Speed (Fr)
The center left value indicates printing speed. By default a 100% value is shown, meaning it is printing at the specified
value in the executed printing program.

This value is modifiable at any time, even when not printing, by just turning the control button. Thus, with a 150%
value it will print 1,5 times faster than stipulated in the printing program.

NOTE: Varying the printing speed modifies the motors speed proportionally and directly to the printing velocity, affecting only
axes X, Y, Z and the extruder but no the temperature, therefore, printing problems can appear when increasing or decreasing
speed to a large degree. It is not recommended to modify this value by more than 50%..

Printing height indicator (2)

The center right value indicates the printing head height.

NOTE: This value might be incorrect when mesured just after switching the printer on, Z=0 actually being the point at
which the printer stopped last time it was used.

Percentage of printing program read (SD)
In the lower part of the screen the percentage of program read is shown. Notice that this value states the percentage
of Gcode lines performed, not the percentage of the object being printed.

Status bar and time elapsed
In the lower right corner, a status bar shows the same information as before.
Above it, time elapsed since printing process started is shown.

Notifications
Last line shows different messages noticing the processes being carried out by the machine.

Actual and target temperature
In the upper left corner four different temperatue values can be visualised, indicating target temperature (up), actual
temperatures mesured by the thermistors (down), hotend temperature (left) and hotbed temperature (right).

r A
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Home menu
To enter the menu, click the wheel from the Home Screen.

Three options are found: Prepare, Control, Print from SD/No SD (according to whether the SD has been inserted into
the slot or not).

http:/www.reprap-electronics.de/

A 2 A2

Prepare menu
Prepare allows you to operate the machine without being actually printing . The following options are found:

» DisableSteppers: Turns the motors off, easing the manual movement of the hotbed and printing head.
= Autohome: Positions the printing head in its home position.

NOTE: Before selecting this option, make sure nothing obstructs the movement of all the axes. Likewise, it is necessary to
perform the calibration process before selecting this option.

= Preheat: Unfolds a list of several materials. Selecting one of them makes the printer preheat to the proper wor-
king temperature for said material.

= Cooldown: Turns off the power of the heating parts.
NOTE: The machine cools down naturally, so the hot parts could be burning for a while.

= Move Axis: It controls axes movement. Select the distance and the axis. To move the axis, turn the control button.
Rotate clockwise to move in the positive direction, anticlockwise for the negative one.

4 7

A2 2B AN =S

- J

NOTE: Before clicking on this option make sure nothing is blocking movement along all the axes. E axis will not move if the
extruder is cooler than a 150°C.
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Control menu

Allows you to modify the printer parameters before and during the printing process. They are much more specific
parameters, requiring a much deeper knowledge of the internal operations of the machine

vV vV

Print from SD /No SD

Allows you to access the SD card and select a stored file to print. If the SD card is not inserted, a No SD message is
shown. In that case, the BCN3DR can be connected to a PC through a USB cable (see printing section)

Print from SD Print from USB
( 7 e N 7
P ==
———
J' B ol
D ® il
= —f—f ;L . e I@'\,‘ i
J L J
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Just for reference, the full menu diagram is shown below:

=

Working with your BCN3DR

The BCN3DR operation diagram from beginning to end is show below. As shown, two alternatives operating
paths are possible:

CAM (Computer Aided Manufacturing) toolchain

SENDER

(USB connection)

Controller
firmware

CAD model |—— | STLfile |— |SLIC3Rutility

(G-code generator)

NS

SD card
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5..STL' FILES
The backbone of BCN3DR printing are the 3D model files.

The most commonly file type found is the *.STL format. An STL file describes a raw unstructured triangulated surfa-
ce. The smaller the triangles are, the bigger the resolution and the detail of the 3D model.

= Basic 5.1 - BONZD12-MOOC M3012 - BCNI012-M10C01LY P MAIUCN!-DL.: Spoel
Froject Edit Repawn  Meshedn  View Setings Help  Upgrade now!

40 (0000688 04Q[doB|4d0s44l44d 40 =]
I : ] 5;‘: scmm.g-mwmncmz-ncr;:l

& Part Repair )
i =oe =

Siatmtcn

Edges 2005 Border edpes:. 0
Tramsgies Fil ] nvald crestatos 0
Sheln 2 Holes: o

Obtaining STL files
There are three different methods:

1) Own design: The users create their own objects with a Computer-aided design best suited for people with pre-
vious knowledge in modeling.

A wide range of available programs exist, some of them free (OpenSCAD, FreeCAD, Blender), while others requiere a
software license (SolidWorks, Rhinoceros, Inventor, etc.). In general terms, all of them allow the user to import/ex-
port STL files.

2) Download: Nowadays there are lots of online repositories where people share their own models with the rest of
the community. As an example, the following ones are mentioned:

» www.grabcad.com - Repository specialized in engineering, design and architecture models. Not always in STL
format but in the original format used by the creator.

» www.thingiverse.com — Repository marketed by MakerBot, contains a great deal of STL models and customiza-
tion tools.

roo
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3) Digitalization: Paralel to the development of 3d printing, home scanning technology is evolving at high speed. In
this regard, it's worth visting Autodesk’s own www.123dapp/catch. In there, free tools to obtain digital models from
pictures taken with a photographic camera are provided.

Other existing methods are: specialized softwares that combine the use of projectors and cameras or 3D scanners.

Editing and repairing a .STL file

As it has been mentioned before, a file in STL format is not always in the best condition. Some of the most common

errors are:

= Holes. The model must be unclosed, with no holes present.

= Faces orientation: An STL model is composed of flat faces. Their orientation must be the same and outwards. In other words,
it cannot be that some sides point in one direction and some in other, they all must be facing outwards. This usually happens

by accident when working with modeling software.

Existen varios software para editar y reparar archivos STL corruptos. RepRapBCN recomienda Netfabb que, en su version

gratuita BASIC permite realizar las operaciones basicas de edicion (escalar, rotar, cortar, combinar, etc.), reparacién y medicion.

http:#/www.netfabb.com/downloadcenter.php?basic=1

The essential information for editing STL files is detailed below. For more detailed information, it is advisable to visit
the official site.

r
20
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Netfabb interface

After installing Netfabb, it is advisable to become familiar with its interface. First of all, we will enable printing volumen visualiza-

tion for our BCN3DR. For this, click on View/Show Platform.

Then, we will redefine volume dimensions. Click on Settings/Settings/General/Default PlatformSize, introducing the

values corresponding to the BCN3DR: 252 x 200 x 200. Lastly, click on Save.

@@

2 metfus Studes Base 49 - perimeter-wt labbproject

In the upper tool bar several icons are found, of which we v e

*.‘.na Fooooes 59060 (%)L

highlight the following ones:

1) 7 basic views

2) Zoom tools

3) Tool to orientate the face of the object to the printing
surface

4) Move, Rotate and Escale tools

5) Repairment tools

2
e

_J.)Juf}ﬁni P- 'l'ﬂ=

In the right part of the screen the model’s basic info and the cutting tool are available.

Repairment

In case the model needs to be repaired before printing, a warning sign will appear in the lower right corner. To repair it, select the

model and click on the tool Repair.

Next, in the right side window, click on Automatic Repair and select

Default Repair in the pop-up window. Click on Execute and then click on Apply Repair in the right side window to

finish the process.

In the new pop-up window, select Remove old part to erase the faulty original file. If the file is successfully repai-

red, the warning sign will be gone.

» Incase the model faces are inverted, the model will be shown in red. In this instance, the model can be repaired

clicking on Part/InvertPart.
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Orientation and move home

First of all, we need to correctly orientate the model, usually on a flat surface. The easiest method is selecting the
tool align to bottom plane and double click the side in contact with the printer’s surface.

Then, the object must be moved to its origin selecting it (represented by the green object) and using the Move tool. In
the pop-up window, click on “To origin” and then “Translate” to finish.

Additional editing options available are cutting and scaling.

Once the model is repaired and edited it's time to save it. Click Part/ExportPart/as STL and save with the desired
name.

2% metfabb Bagic 5.1 - BCN3ID1.2-MOOC00.0R000 BCMED12 - BONIDL.2-M10COLOPO0D Spoct mount-1 BCNIDL2-MOLCON.0PISA Spocl holder- 4 fabbproject M
Progect  Edit Part Exte View Seftingt  Help  Upgrade now!
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Upgrade now!

G-CODE generation

At this point, we've got a 3D model ready to print. However, a last step is required. The STL file must be converted to
file type the printer can read in order to fabricate the model. In other words, the G-Code file must be generated.

Gcode is a programming language used to control CNC machines, including the majority of 3d printers. It consists of
a set of instructions that tell the machine the positions and speed at which each of the axes must move and also the

hotend and hotbend temperatures.

There are several tools to generate a Gcode file from a STL file. RepRapBCN recommends using Slic3r, an open source
software that is constantly updated, with new functionalities added.

http:#/slic3rorg/download

r.
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Like other GCodes generators, Slic3r sections the 3D model in layers that will be later deposited to created the 3D
model. In every layer, a distinction is made between the perimeters and the filling of the part. Also, the operational
sequence, printing speed, number of perimeters, etc can be chosen. Since there are many parameters, some of them
difficult to understand, specific configurations have been prepared to ease up the process for the novice user.

Slic3r configuration

The following printing profiles have been prepared for the BCN3DR with a 0,4mm nozzle in mind, taking into account
the kind of object and later use.

These must be taken as a reference point and can be improved to go faster, achieve a better finish, etc.

ST: Standard configuration with a layer height of 0,2mm for most builds
HQ: High quality standard configuration with a layer height of 0,7mm
HS: Setting targeted at jobs needing a fast print without loosing much quality

SV: Special configuration for container-like pieces. There is no infill present and the object is manufactured helically
with a single surface, improving the surface finish.

WALL: Special setting for models with exotic geometries like the ones generated with the Voronoi algorithm (being
the designer Dizingof its best representative). There's no filler present and the temperature and speed are lowered to

improve overhangs construction.

STR: Special setting for parts suffering from a significant mechanical stress. The filling is made in a honeycomb
fashion and the layer height is decreased to 0.15mm to improve adhesion between the layers.

Slic3r FIRST STEPS

We will now explore the key points needed to use Slic3R. To gain a deeper knowledge please visit the official website
of the Project and download the manual:

http:#manual.slic3rorg/

.
23
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Printer definition
A setup wizard will appear the first time Slic3r is executed. The following information must be entered:

1) Firmware Type: RepRap (Marlin/Sprinter)
2) BedSize: x: 252 y: 200 mm

3) NozzleDiameter: 0.4mm

4) FilamentDiameter: 2.9 mm

5) ExtrusionTemperature: 220°C

6) BedTemperature: 55°C

e —

Welcome to the Slic3r Configuration Wizard

@ Welcome Hello, welcome to Slic3r! This wizard helps you with the initial configuration; just
Firmware Type a few settings and you will be ready to print.

Bed Size
To impaort an existing configuration instead, cancel this wizard and use the Open

Mozzle Diameter Config menu item found in the File menu.

Filament Diameter

Extrusion Temperature To continue, click Next.,
Bed Temperature

Finish

Loading a profile
Once configured, we can load the best suited printing profile to the kind of object we are about to print. To do that, we
must go to File/Load Config... and select the preferred configuration.

Select urati
@ Slic3 .. ¥ Configuraciones Slic3r = | 43 Ml Buscar Configuraciones Slicir 0
File Plater Window Help 4
Plater ‘ Print Sel'nngsl Filament Settings | Printer Seﬂmgsl Organizar ~ Nueva carpeta =~ O @
[Q'g Add... ][rfg Delete Hx Delete All ”gg Arrange ]@ @ @f A Favoritas “ Nombre Fecha de modifica.. Tipo
Name 18 Descargas |4 pLA ST 0314 10/07/2014 14:13 Opciones de con|
gcmzmi | M Escritorio

‘% Sitios recientes

4 Bibliotecas
@ Documentos
g [&] Imégenes
: J’ Musica
= B videos
Q '8 Eauino = [l n b
i
MNombre: PLA_ST 0314 - [0 fies ini -
Info ==
siee || [ abir |v] [ canceler |
Facets: || B
eI Manitold: ez

Loaded BCN3D1.2-M10C00.0P01A Spool holder right.STL
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Adding files
Next, add the previously edited and repaired STL. The can be directly dragged over the platform or be added by clic-

king on. You can add as many files as you like.
Also, more than one copy can be printed. You just only have to slect the outline of the object =or select it in the right

side list) to duplicate and click the “+" button as many times as needed.

% Slicar
File Plater Window Help

I Plater |PlintSettin9s | Fil t Settings | Printer Setti =_|
’l’:a Add... ” Delete ” Delete All ” Arrange ”:”:”:”:” Rotate... ” Scale.. | 28 Split ” View/Cut... ” Setting4

Mame Cop... Scale
| Export G-code.. |

| Export STL... |

Drag your objects here

ol

Info
Size: Wolume:

Facets: Materials:
Manifold:

Versien 1.1.5 - Remember te check for updates at http://slic3r.org/

Exporting Gcode
Once the object has been deployed over the platform and the configuration adjusted, it's time to export the GCode.

Click on Export G-Code and specify the saving location and file name, creating a file with the *gcode extension.

File Plater Window Help

Plater | Print Settings | Filament Settings | Printer Settings|
[ Add.. ][ Delete ][ Delete All | Anange |[0)[@](6][2][@ Rotate.. |[} I scale... [ spit || ) view/Cut... [ Settingg

MName Cop... Scale|

BCN3D1.2-M10C00.0P0... 1 100% |[.e3Export G-code...
Export STL...

Y =105

< I | 3

Info

Size: 5317 x57.05 x15.00 Volume: 1110126
Facets: 3342 (1 shells) Materials: 1
Manifold: Yes

X=121.25
Loaded BCN3D1.2-M10C00.0P01A Spool holder right.STL
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This generating process might take a while depending on the 3D model complexity and the setup chosen. Likewise,
the computer’s power is decisive too. Processing time is between 10 and 15 minutes depending on the complexity.

Transferring our G-CODE to the BCN3DR

Finally, we just have to transfer the GCode to the printer to start the print. To do that, two different procedures are
available.

1) Using the LCD. Insert an SD containing the Gcode file you want to print in the lateral slot card of the screen and
press the control button and choose Print from SD to select the object.

2) PC connection. Use a software to connect the printer via USB. RepRapBCN
recommends RepetierHost

http:#/www.repetier.com/download/

It's a free open source program that allows you to visualize STL files, automatically generate the GCode from precon-
figured profiles and monitor the printing progress.

A simpler alternative to RepetierHost is Printrun

https:#/github.com/kliment/Printrun

6. IMPRESION DESDE TARJETA SD Y USB

En la tarjeta SD que acompana a laBCN3DR se encuentran de archivos Gcode precargados para realizar las primeras
impresiones. A continuacion se describen las caracteristicas de cada figura:

= Cube: A 20mm sided cube with a 25 % filling value ideal to check if the calibration and setup of the printer are co-
rrect. It's the perfect figure to check the parallelism and the dimensional accuracy of the printer.

Material: PLA
Layer Height: 0,2mm
Working time: 15 minutes

= Tower: The tower is a good example of a detailed object. The bricks of the exterior and the steps of the interior
stairs, together with the central spiral, are a good mesure of printing quality.

Material: PLA
Layer Height: 0,7mm
Working time: 2 hours 15 minutes
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After selecting the piece to be printed, and having calibrated the machine and checked that everything works co-
rrectly, proceed as follows:

«  Make sure PLA is loaded in the machine

» Preheat the printer using the following commands in the LCD:

Home Menu > Prepare > Preheat PLA

= Once working temperature is reached,clean out excess material:
Home Menu > Prepare > Move axis > Tmm > Extruder

Turn the wheel clockwise until the material flows continously through the nozzle. Then clean out the extruded mate-
rial.

» Insert the SD card into the left side slot of the display screen, paying attention to the position of the card.

» Start printing by selecting the desired file:

Home Menu > Printfrom SD > Fila_name

The print process wil start. Attention should be paid to the manufacturing process, especially during the first uses.
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7. FILAMENT

BCN3DR achives its best printing results with PLA, ABS andy Nylon, while accepting many other plastic materials in
3 mm filament format.

A brief description of the materials currently accepted follows:

PLA

PLA (polylactic acid) is the quintessential material for 3d printing, thanks to its ease of use through deposition. It is
recommended to begin in this type of manufacturing technology with this material. A great variety of colors exists
and complex geometries can be achived without great difficulty. The finish is slightly glossy or semi-matte.

Printing is carried out at temperatures ranging between 195° and 220° C, depending on the supplier of the material
and printing speed. A layer fan is required to build overhangs. It easily attaches to the glass, and if you work at a

hotbed temperature ranging 45° C-55° C, no product is requiered to ensure this adherence.

The mechanical properties are average, but presents a certain fragility in parts requiring deformation, from a tempe-
rature of about 50 °, the parts can present it. It is dissolved in caustic soda.

8. FIRMWARE

What is a firmware and when to update it?

The firmware is a software needed to control a hardware. Namely, it is the internal program that controls your
BCN3D +, and allows it to perform its functions normally. The BCN3D + is delivered and installed with the latest
firmware version published on the web.

Its basic functions are:

On the one hand, converting .gcode files to useful instructions for printing, managing the motor drivers and target
temperatures.

On the other hand, it is also responsible for managing machine peripherals such as the screen, allowing you to inte-
ract with it without connecting the printer to a computer, or the endstops necessary for proper functioning of your

printer.

Usually the firmware of a device is integrated in it and you can not change or replace it unless aproved and provided
by the manufacturer.

The advantage of our RepRap printer is that it follows the Open Source philosophy so we can change or modify the
firmware to adapt our machine to new features and accessories or improve its behavior.

The ability to modify the firmware is the responsibility of each user. RepRapBCN will always develope firmwares
oriented to printing with their products and will freely disseminated them.
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When it is necessary to update the firmware?

It will be always necessary when adding new functionalities that imply a change in its control system such as new
extruder head, Dual extruder heads or a Paste extruder. Changing other parameters such as pulleys or axes lenght,
printing speed and endstops will also need a firmware update.

When RepRapBCN publishes a new update, it will be announced through its web site and social networks,
highlighting improvements and new features.

Downloading Arduino’s IDE

This section describes the steps to update / modify the controller firmware. The first step is to install the Arduino IDE
on a computer. This is a program that enables us to interact with BCN3D + Arduino card.

1. Download Arduino’s software package from http:#/www.reprapbcn.com o execute from the provided USB
dongle.

2. Install the program.

3. Onceinstalled, plug the BCN3DR to the computer through a USB cable, thus the connection with the Arduino
board being established.

If the board drivers are not installed automatically, please follow the steps below:

http:#/arduino.cc/en/guide/windows#toc3

4. Open the Arduino manager 2 e it i TSR
(Richiro) iditae Sketch Hemamienaus. Ayuda
. . . Abrir... Cerle O
5. From File>Open, select the saved new firmware file. Skechbook
. . . e . . . Eemplos »
The file has the *.ino extension and it's located in a folder with the same name. came cetew
;::falr(eme.. c;;:ummuu,.s
. . . Cargar Cerlel
6. Now the desired parameters can be modified if necessary. Chrger sando Progarmader Mt
:np-i:'\- . ;m-P
7. Select the card model and port usingHerramientas>Tarjeta>Arduino Mega — q’"”
2560 and Herramientas>Puerto Serial>COM X

»  The card used by the BCN3DR is an Arduino Mega 2560.

»  Port means the connector through which the board is connected to the
computer (COM port). It can be checked from Start> Computer> Right
click> Properties> Device Manager> Ports COM and LPT (Windows)
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8. Click on Load.

Loading starts, first compiling the program for errors, and then, properly speaking, loading the firmware on the me-

mory board.

9. |Ifthe process is completed successfully the message Charge completed is displayed and the printer is ready to use.

170377014 1009
o: 1,78 KB
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9. TROUBLESHOOTING

It's difficult to remove an object once it's done

Once a print is finished, it's sometimes difficult to pull it out of the platform:

= Useless amount of lac.

= Itis highly recommended to remove the cristal base by loosening the white screws. If you try to extract the
printed part directly without removing the glass first, you could be forcing the screws and/or misaligning
the platform.

Motors do not rotate correctly (adjusting the pololus)

From Home Menu/LCD Prepare/Move Axis, the proper movement of the motors

5 min.
can be cheked by moving the axes. We will proceed as follows: V
1. Before we start, use your own hands to check nothing is hindering the motors
movement.. If there’s still no movement, adjust the pololus following this instructions: 5 min W

2. If the motors do not move or do not move enough,
They are lacking power. Turn off the machine and turn the potentiometer clock
pololu 5 minutes clockwise.

3. If the motors move but, from time to time, make sudden movements, ie, lose steps, they have too much power. In
that case, turn off the machine and turn the potentiometer clock pololu 5 minutes anticlockwise.

NOTE: before clicking on this option, make sure nothing obstructs the movement of all the axes. E axis will not move unless
the extruder is hotter than 150°C.

Extrusion stops

It could happen for several reasons:

» The motor does not properly rotate:

1. Adjust pololus power.

2. Check that the large gear axle nuts are not too tightened up against the extruder, but against each other. Ensure
that the actuating mechanism rotates easily by hand.

3. Check for flaws in the electrical cables and that they are properly connected.

The thread does not advance even when the motor is running:

Make sure the temperature is correct according to the type of plastic.

Remove the extruder and thoroughly clean any remaining plastic.

Raise the machine temperature and, using your own hands, try to get rid of the clog jamming the extruder.

w N =
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» The message "“Mintemp” or “Maxtemp" appears on screen:

1. Hotend temperatura has left its working range. Make sure connections are secure and wiring is not damaged.

2. If the problem persists, remove the hotend from the machine and make sure the thermistor is not broken and the wires
are not touching, which would cause a short circuit and a misreading of temperature.

= Theglass is too close to the nozzle:
1. Tighten the screws on the base or adjust the Z axis endstop a little higher and start again.
2. Recalibrate the base.

The screen does not responde or nothing is shown

Para realizar los movimiento en los ejes X e Y el Arduino necesita realizar muchos calculos matematicos complejos
que requieren gran parte de la capacidad de procesado, por esta razén es posible que se produzcan error puntuales en
el muestreo de la pantalla. Para solucionarlos:

1. Apretar el botén del menu para acceder al men( principal
2. Seleccionar la opcion superior ‘Info screen’ para volver al men( de informacion anterior.

De esta forma la pantalla se actualizara y volvera a mostrar la informacion correctamente, si no sucede esto, realizar
uno de los pasos siguientes (por este orden):

1. Turn the printer off and back on.

2. Make sure that the cables that feed the display are properly connected. The two cables coming from the electro-
nics must croos each other

3. Reload the firmware using a pc. If the firmware is incorrectly loaded a blank screen will appear (see section 8,
Firmware)

X.Y or Z carriage does not move fluently

1. Clean the guides.
2. Loosen the screws holding the guides.

10. PRINT QUALITY DIAGNOSTICS

This sections shows alist of the most common printing quality problems and how to minimize them.

Regardless, we recommend using our web configurations (www.reprapbcn.com) because they have been tested and
work well with most objects.

The part becomes separated from the hotbed (WARPING)

Sometimes the parts do not properly adhere to the glass hotbed during printing. This especially happens printing with
ABS, a material with great thermal contraction.
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In this case, try the following steps:

1. Clean the glass to prevent dust or other substances interfere between the base and the piece.

2. Soak the glass surface with a layer of the included adhesive spray

3. Raise the base temperature five degrees celsius.

4. Calibrate the base as shown in section 11 Maintenance.

5. Print the first layer with the hotend closer to the base. To do this, loosen the three screws from the base an
eighth of the way or loosen the screw that actuates the Z axis endstop a fifth of the way. The two actions will get the
base and hotend 0.1mm closer so the first layer adheres better.

6. Make the first layer extrude more material (from Slic3r, PrintSettings/Advanced/FirstLayer).

First layer material is not extruded throughout its geometry

1. It might happen that the first layer does not adhere properly to the glass, or leaves a steady stream of plastic
thread (little droplets forming a line) throughout the figure. The problem is that the machine is not correctly calibra-
ted; the extruder is too far from the base. Check the calibration section in chapter 11 (Maintenance) to see how to
regulate the Z axis endstop.

2. The symptons above are present in just part of the first layer. The reason being that the printer is not correctly cali-
brated, the X axis is not parallel to the base and this causes the extruder to move away from or get too close to the base at
some points. Check the calibration process section in chapter 11 (Maintenance) to know further about orienting the printer
dock. 11 Maintenance, focusing on the orientation of the plane of the printer dock.

Cracks appear in the middle of the piece

This happens because the area of the piece closest to the extruder is hotter than the
lower layers.

To avoid these cracks the extrusion temperatura must be raised five degrees celsius, so
that the layers adhere more strongly.

Fused

When working with fused material, gravity causes it to drip from the nozzle. Strategies
to minimize this problem and achieve better surface finishes, even with complex geo-
N\ metries, should be seek.

Deposition

The thread of material being extruded has the outer diameter of the nozzle orifice. By
depositing the fused thread layer by layer, the entire surface of the part is printed.
Note that the manufacturing process occurs sequentially, which allows differentia-
tion between different aspects of each model (such as perimeters and filler) and
choose among different print strategies (order, framework and filling rate, etc).
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Strings of plastic appear around the piece

This happens when the extruder is moved from one point to another without depositing material.

To avoid this, set the retract option in Slic3r. It retracts part of the extruder motor wire, so that the pressure of the
material inside the extruder is reduced and dripping is prevented during axes movement. If the retract increases,
there's a decrease in string-shaped waste.

Modeling

The higher we print, the need for support structures becomes more obvious.Deposited material tends to detach itself
in steep areas or hanging parts such as overhangs.

When this happens, it's recommended to make use of Slicr options regarding the creation of support colums.

One layer is displaced relative to the lower one

When there is a discrepancy between layers position, it is likely that one of the motors lost steps. Firstly, you must
identify which axis is affected and then adjust that motor’s pololy, as explained in section 9 (Troubleshooting).
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11. MAINTENANCE

Given the machine characteristics, it is very important to periodically check the different components so we don't lose
print quality and to avoid errors.

Rods lubrication

Oiling the rods from time to time is recommended, especially when they suffer from difficulties moving or make more
noise than usual. Place a few drops on the rods, and move the axes so that the mechanism distributes it uniformly.

The same process should be applied to the two Z threaded rods.

Filament maintenance

Filament spools should be stored in a cool, dry place as heat and humidity affects this kind of plastic. If a coil is not to be
used for a long period of time, store it in a sealed plastic bag.

Ensure that the filament is neatly coiled. A loose coil can cause it to curl incorrectly, and cause jerks affecting printing and
the machine components.

Cleaning the printer dock

After several prints, the hotbed glass gets dirty, and layers of adhesive coating, plastic dust and debris accumulate. To
clean the glass, it must be removed from the printer. The remains of the coating and dust are easily removed by placing the

glass under water with a little soap.

Any remaining plastic stuck to the dock can be removed with a boxcutter, being careful not to scratch the glass. Acetone
can also be used as it acts as a solvent.

12. TIPS AND TRICKS

There are certain things that we must take into account when using and maintaining the machine:

» Do not spill liquids on the hotbed or hotend as they could damage the other components. To clean individual
machine parts, first remove them from the machine. The only advised product for improved printing adhesion is
the coating spray included with the machine.

» If difficulties are encountered while removing the printed objects, remove the glass first to avoid decalibration.

» Do not overheat the hotend. Although its maximun temperature is firmware limited, do not use other methods to
heat it above the established range.

» Do not handle the electronic parts of the machine when it is on, it could cause damage to its components.

» Do not turn off the printer immediately after printing. Allow some time for the fans to cool the different compo-
nents down.
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13. REPRAPBCN TECH SUPPORT

If you do not find in this manual a solution to your problem, you can contact the REPRAPBCN team via the following
channels:

Forum

Before taking any other action, you should have a look at our forum. It is very likely another user has suffered the
same problem, and the forum is where most of them are solved.

http:#/www.reprapbcn.com/es/forum

E-mail

If the problem persists, you can contact us directly by email. An expert from RepRapBCN will answer you back with a
solution as soon as possible.

info@reprapbcn.com

Customer Service

Call our customer service line:
+34 93 473 88 24 (TECH SUPPORT)
+3493 3487025

Call this numbers to contact our team, to get either a direct answer to your question or to make an appointment and
have your printer checked in our facilities.

This information is also available in our website contact section:

http:/www.reprapbcn.com/es/contact

In any case, it is very important to attach the printer serial number so we can keep track of it and know in advance
any problems that may arise. A photograph could also help identify more easily what has happened.

14. GLOSSARY

= Arduino. Free hardware platform based on a board with a microcontroller and a development environment.
Itis a very popular board, and constitutes the brain of the BCN3D+. Requires the download and installation of firmware to work.

http:/www.arduino.cc/

= Endstop. The electro-mechanical component that makes contact with the axis carriages to indicate their total
range.
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Filament: Coil of any valid printable material.

Firmware:. BCN3D + Internal Code which governs all electronic and allows printing. BCN3D + uses its own fir-
mware, based on the popular Marlin.

Power supply: Used to power the device, adapted to the printer's needs

Gcode: Files in G-Code format containing the printing instructions for a given figure. They're loaded onto the SD
card so that they can be read and printed.

Hotbed: Heated base on which the models are printed
Hotend or Extruder: Where heat is applied to melt and print the filament.
SD Card: Card where the files are stored in Gcode format for printing..

Nettfab: Recommended by RepRapBCN to edit and repair STL files.

http:#/www.netfabb.com/downloadcenter.php?basic=1

Open Source. Freely developed and distributed software
Pololu. An electronic component that controls the functioning of the printer motors.

RepetierHost. Software that allows sending Gcode files directly from the PC to the machine via a USB cable. It
has other features like print monitoring.

http:/www.repetier.com/

RAMPS 1.4. Stands for RepRapArduino Mega PololuShield. It's a microcontroller board designed specifically to
complement the printer circuit. Contains a fuse to prevent the destruction of the Arduino board in case of an
electrical surge.
Slicer: RepRapBCN recommended software to generate Geode files from STL files.

http:#/slic3r.org/

Thermistors. Temperature sensors. Found in the hotbed and hotend.

Layer fan. Fan located next to where the fused material is ejected, cooling it to match the temperature of the
already printed material.
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15. WARRANTY, REFUNDS AND REPLACEMENT POLICY

RepRapBCN does not offer a long term warranty. Every component has a one year warranty. RepRapBCN accepts
returns for any unaffected item within 14 calendar days from the date of receipt of merchandise. After such time,
all sales are considered final. Unaffected means a device has never been assembled, powered up, programmed, or
otherwise changed. RepRapBCn cannot accept returns on purchased items that have had electrical power applied to
them, or been otherwise programmed, changed, or affected

However, we do offer spare parts and technical assistance for items proven to suffer from a manufacturing defect
and we will work with you to get your printer back to work

16. TERMS OF SERVICE

All the information contained in this manual is subject to change at any time without notice and it is offer just for
convenience. purposes only.

RepRapBCN reserves the right to modify or revise this manual at any time. You accept being subject to any modifica-
tion and/or revision. . Please contact RepRapBCN support tem if you want to obtained the most updated information.

The design of this manual and all text, graphics, information, content, and other material displayed are protected by
copyright, trademark and other laws

Certain trademarks, trade names, service marks and logos used or displayed on this Website are registered and
unregistered trademarks, trade names and service marks of RepRapBCN and its affiliates. Nothing contained on
this manual grants or should be construed as granting, by implication, estoppel, or otherwise, any license or right to
use any trademarks, trade names, service marks or logos displayed on this manual without the written permission
of RepRapBCN or such other owner. Any unauthorized use of the information, materials or trademarks included in
this manual might incur in violation of copyright laws, trademark laws, privacy and publicity laws and other laws and
regulations.
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